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1  Информация о документе

1.1  Функция документа
Данное руководство по эксплуатации содержит информацию, необходимую для
использования программного обеспечения: начиная с описания программного
продукта, его установки и использования и завершая интеграцией в систему,
управлением, диагностикой, устранением неисправностей, обновлением и удалением.

1.2  Символы

1.2.1  Символы по технике безопасности

Символ Значение

ΟΠΑCHO

ОПАСНО!
Этот символ предупреждает об опасной ситуации. Допущение такой ситуации
приведет к серьезным или смертельным травмам.

ОСТОРОЖНО

ОСТОРОЖНО!
Этот символ предупреждает об опасной ситуации. Допущение такой ситуации
может привести к серьезным или смертельным травмам.

ВНИМАНИЕ

ВНИМАНИЕ!
Этот символ предупреждает об опасной ситуации. Допущение такой ситуации
может привести к травмам небольшой и средней тяжести.

УВЕДОМЛЕНИЕ
ВНИМАНИЕ!
В этом символе содержится информация о процедуре и другие факты, которые не
приводят к травмам.

1.2.2  Описание информационных символов

Символ Значение

Допустимо
Означает допустимые процедуры, процессы или действия.

Предпочтительно
Означает предпочтительные процедуры, процессы или действия.

Запрещено
Означает запрещенные процедуры, процессы или действия.

Подсказка
Указывает на дополнительную информацию.

Ссылка на документ

A Ссылка на страницу

Ссылка на схему

Примечание или отдельный шаг, на которые следует обратить внимание

1. , 2. , 3.… Серия этапов

Результат этапа

Помощь в случае проблемы

Внешний осмотр
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1.2.3  Символы, используемые в ПО FieldCare

Символ Значение

Запуск нового проекта.

Открывание существующего проекта.

Сохранение открытого проекта.

Печать открытого проекта.

Открывание буфера обмена.

Отображение каталога DTM.

Открывание документации для выбранного прибора или получение подробных сведений о нем.

Открывание инвентарного списка.

Активация протокола.

Добавление прибора к сети.

Удаление прибора из сети.

Создание новой сетевой топологии с помощью CommDTM и DeviceDTM.

Сравнение топологии сети периферийных устройств с фактической физической сетью, и
добавление устройств в существующую сеть.

Сканирование предварительно настроенной топологии и отображение отчета с информацией о
сканированном приборе.

Указание сведений о наличии соединения с прибором.

Передача информации из прибора в ПО FieldCare.

Передача информации из ПО FieldCare в прибор.

Функции, специфичные для выбранного прибора.

Добавление уровня установки.

Добавление элемента.

Удаление уровня установки.

Удаление элемента.

Открывание контрольного списка приборов для отображения выбранных приборов на
установке.

Подтверждение замены прибора.

Отсоединено.  1)
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Символ Значение

Установка связи, готовность к связи.  1)

Канал связи занят или операция связи отменена. 1)

Подключено.  1)

Символ W@M, после установки соединения с системой W@M отображается в нижнем правом
углу строки состояния.

Включение сенсорного режима.

Выключение сенсорного режима.

1) Индикатор состояния: указание сетевого/автономного состояния приборов в представлениях
установки и сети

1.3  Выделение текста

Выделение Значение Пример

Полужирный шрифт Клавиши, кнопки, значки программ,
вкладки, меню, команды

Start → Programs → Endress+Hauser
В меню File выберите пункт Print.

Угловые скобки Переменные <DVD drive>

1.4  Используемые аббревиатуры

Аббревиатура Значение

APL Advanced Physical Layer (расширенный физический уровень)

CSV Значения, разделенные запятыми

DTM Device Type Manager (менеджер типов устройств; драйвер устройства)

FDI Field Device Integration (интеграция полевых приборов)

FDT Field Device Tool (инструмент для полевых приборов)

HART Магистральный адресуемый дистанционный преобразователь

I/O Ввод/вывод

IO-Link Фирменное наименование системы связи, включающей интеллектуальные датчики и
исполнительные механизмы

IODD Описание электронного устройства (описание устройства ввода/вывода)

IP Интернет-протокол

PROFIBUS Технологическая полевая шина

PROFINET Технологическая полевая сеть

SLM Управление лицензиями на ПО

TCP Протокол управления передачей

UDP Протокол передачи датаграмм

ВПИ Унифицированный определитель местонахождения ресурса

W@M Управление активами через Интернет
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1.5  Документация
FieldCare SFE500
• Вводное руководство KA01303S/04/A2
• Учебное руководство по проектам FieldCare SD01928S/04/EN
• Техническое описание TI00028S/04/RU

1.6  Зарегистрированные товарные знаки
PROFINET® — зарегистрированный товарный знак PROFIBUS Nutzerorganisation e.V.
(организация пользователей PROFIBUS), Карлсруэ, Германия.

PROFIBUS® — зарегистрированный товарный знак PROFIBUS Nutzerorganisation e.V.
(организация пользователей PROFIBUS), Карлсруэ, Германия.

IO-Link® — зарегистрированный товарный знак организации IO-Link Consortium/IO-
Link Community, организации пользователей PROFIBUS Nutzerorganisation e.V. (PNO),
Карлсруэ, Германия

FOUNDATIONTM Fieldbus — товарный знак компании FieldComm Group, Остин, Техас
78759, США.

HART®, WirelessHART® — зарегистрированный товарный знак FieldComm Group,
Остин, Техас 78759, США.

Ethernet/IP — зарегистрированный товарный знак ODVA, Мичиган, США.

Modbus® — зарегистрированный товарный знак организации Modbus, Хопкинтон,
США

Все прочие торговые марки и названия продуктов являются товарными знаками или
зарегистрированными товарными знаками соответствующих компаний и
организаций.
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2  Основные указания по технике
безопасности

2.1  Требования к работе персонала
Физический и электронный доступ к периферийным приборам, сетям, компьютерам и
системам должен быть разрешен только группе уполномоченных лиц. Следовательно,
должна использоваться система доступа на основе уровней доступа. Внедрите
детализированные руководства и процессы по ограничению доступа к ПК и другому
оборудованию только группой уполномоченных лиц.

2.2  Назначение
FieldCare является средством управления активами предприятия на основе
технологии FDT («Инструмент для периферийных приборов»), которое в зависимости
от версии может использоваться для настройки устройств, управления приборами или
мониторинга состояния. С помощью соответствующих типовых драйверов (DTM) эта
программа управляет периферийными устройствами и компонентами системы
независимо от протокола связи.

Необходимо использовать корректно настроенный межсетевой экран, который
блокирует все данные, не соответствующие требованиям безопасности. Для
дальнейшего повышения уровня безопасности необходимо отключить
неиспользуемые порты и ввести демилитаризованную зону или систему обнаружения
вторжений. Следует организовать стабильный процесс исправления ошибок в режиме
реального времени для всех средств и инструментов, таких как операционные
системы, интернет-браузеры, программы, приложения, базы данных и драйверы. На
ПК необходимо установить антивирусное программное обеспечение. Аппаратное,
программное обеспечение, встроенное ПО и другие компоненты электроники следует
использовать только в том случае, если они предоставлены надежными источниками.

Для электронного доступа к программам, например для ПК, FieldCare, серверов SQL и
периферийных приборов рекомендуется использовать надежные пароли.
• Пароль должен содержать не менее 8 символов
• Не используйте имя пользователя, собственное имя или название компании
• Пароль не должен содержать полное слово
• Пароль должен значительно отличаться от прежних паролей
• Он должен содержать заглавные и строчные буквы, цифры и символы
• Пароль необходимо регулярно менять

2.3  Безопасность продукции
DEP – предотвращение выполнения данных
DEP – это инструмент обеспечения безопасности, который позволяет защитить
компьютер от вирусов, повреждений и угроз безопасности. Контролируя работу
программ, средство DEP содействует защите компьютера и обеспечивает безопасное
использование приложениями системной памяти. Как только приложение пытается
получить доступ к программе, средство DEP закрывает программу.

Настройка инструмента DEP
1. Выберите пункты: Windows key → Pause key → Advanced system settings →

Advanced.

2. В ответ на предложение системы введите пароль администратора.

3. Выберите пункт: Performance → Settings.
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4. Откройте вкладку Data Execution Prevention и выберите пункт Turn on DEP for
All Programs and Services. Если программы нет в списке, нажмите кнопку Add,
выберите программу и нажмите кнопку Open.

5. Нажмите кнопку OK.
 Будет отображено окно System properties.

6. Нажмите кнопку OK.

7. Перезагрузите компьютер, чтобы активировать изменения.

Номер Пояснение Состояние

0 Всегда выключено Средство DEP выключено для всех процессов.

1 Всегда включено Средство DEP включено для всех процессов.

2 Явное согласие Средство DEP включено для основных программ и служб Windows, вариант
по умолчанию.

3 Явный отказ Средство DEP доступно для всех процессов, кроме программ и служб.

Технические усовершенствования
Компания Endress+Hauser оставляет за собой право вносить технические улучшения в
программное обеспечение и устройства в любое время и без предварительного
уведомления. Если такие улучшения не влияют на работу программного обеспечения,
они не документируются. Если улучшения влияют на работу, составляется и
публикуется новая версия руководства по эксплуатации.

2.4  IT-безопасность
Гарантия изготовителя действует только при условии, что изделие смонтирован и
эксплуатируется в соответствии с настоящим руководством по эксплуатации. Изделие
имеет встроенные механизмы обеспечения защиты, предотвращающие внесение
каких-либо непреднамеренных изменений в его настройки.

Оператор должен самостоятельно реализовать меры по IT-безопасности,
дополнительно защищающие изделие и связанные с ним процессы обмена данными,
в соответствии со стандартами безопасности, принятыми на конкретном
предприятии.
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3  Описание продукта

3.1  Функции ПО
В настоящем руководстве по эксплуатации описано использование ПО FieldCare для
соединения с приборами, которые оснащены интерфейсами HART, PROFIBUS,
FOUNDATION Fieldbus, Modbus, IO-Link и EtherNet/IP, с помощью модемов, шлюзов и
систем дистанционного ввода/вывода.

3.1.1  Управление лицензиями на ПО (SLM)
Подробные сведения об обновлении ПО см. во вводном руководстве «Управление
лицензиями на ПО (SLM)» →   7

3.1.2  Уровни доступа
Сразу после установки ПО FieldCare функция пользовательского входа в систему
деактивирована, поэтому программу FieldCare можно запустить, не выполняя
процедуру входа в систему.

Активация пользовательского входа в систему
1. Разверните пункт FieldCare Administrator →   14.

2.

Выберите пункт User and User Groups → Configuration и установите флажок
User Login active.

Уровни доступа
Предусмотрены различные уровни доступа. Каждый пользователь может войти в
систему с определенным уровнем доступа, который ему назначен. Пользователь
получает полномочия на выполнение определенных функций. Это позволяет
предоставлять доступ к техническим и эксплуатационным функциям только тем
пользователям, которым это разрешено. Кроме того, предоставление прав доступа
можно ограничить определенным периодом.

• Создайте какое-либо количество пользовательских учетных записей
• По желанию установите параметры настройки для учетных записей
• По желанию измените пароль
• Пользователь может изменить пароль
• Пользовательский пароль действителен в течение определенного времени
• При необходимости удаляйте пользовательские учетные записи
• Назначайте уровни доступа пользователям согласно стандарту FDT

Уровень доступа Права доступа

Administrator Неограниченный доступ к выполнению любых функций, например разработке,
вводу в эксплуатацию и эксплуатации в ПО FieldCare.

Выполнение административных задач, например распоряжение
пользовательскими учетными записями.

Изменение или обновление каталога DTM.

Planning engineer Неограниченный доступ к выполнению любых функций, например разработке,
вводу в эксплуатацию и эксплуатации в ПО FieldCare.
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Уровень доступа Права доступа

Maintenance engineer Выполнение разрешенных функций в ходе ввода в эксплуатацию и во время
эксплуатации.

Замена, калибровка и регулировка приборов.

Запись параметров в память приборов, изменение или чтение параметров.

Выполнение специфичных для приборов операций в интерактивном режиме.

User Выполнение разрешенных функций в ходе ввода в эксплуатацию и во время
эксплуатации.

Контроль и ведение текущего технологического процесса.

Проверка текущего состояния прибора.

Изменение уставки для обеспечения корректной работы прибора.

Observer Контроль и ведение текущего технологического процесса.

Чтение параметров прибора и документации на подключенные устройства.

3.2  Назначение
Программа FieldCare представляет собой универсальный инструмент для выполнения
функций настройки и управления в отношении интеллектуальных полевых приборов.
Обеспечивает удобную настройку приборов, управление процессом технического
обслуживания, техническое обслуживание на основе состояния и управление
жизненным циклом прибора. Возможна адаптация под различные потребности в
зависимости от условий лицензии с возможностью расширения в любое время.
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4  Установка
Подробные сведения об установке см. во вводном руководстве →   7
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5  Управление

5.1  Запустите ПО FieldCare.
‣

Откройте программу FieldCare.
 Открывается окно программы FieldCare.

5.2  Привязка ПО FieldCare к порталу W@M.
Требования для подключения ПО FieldCare к порталу W@M.
• Должны быть установлены компоненты FieldCare/FieldCare Administration и

W@M
• Компонент W@M обычно устанавливается на сервере
• Компонент FieldCare/FieldCare Administration обычно устанавливается на ПК
• Оформите контракт для портала W@M и создайте учетные записи

пользователей
• Создайте пользовательскую учетную запись и пароль на портале W@M

5.2.1  Выполнение настроек в ПО FieldCare.
1. Запустите программу FieldCare→   13.

2. Закройте диалоговое окно FieldCare.
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3. Выберите пункт Extras → Options.
 Открывается диалоговое окно Options.

4. Откройте вкладку W@M.
 Открывается вкладка W@M.

5. Установите флажок Enabled, затем установите переключатель Serial Number
(default).
 Идентификация приборов между порталом W@M и ПО FieldCare будет

согласована по серийным номерам.

5.2.2  Выполнение настроек компонента FieldCare.
Закройте программу FieldCare, прежде чем запустить программный компонент
FieldCare Administration.
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1.

Запустите программу FieldCare Administration.
 Открывается диалоговое окно FieldCare Administrator Login.

2. Введите строку Administrator в поле имени пользователя и строку Admin в поле
пароля, затем нажмите кнопку Login.
 Открывается диалоговое окно FieldCare Admin.
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3. Выберите пункт W@M Configuration.
 Открывается окно W@M Configuration.

4. Выберите пункт W@M Portal URL и нажмите кнопку Apply.

5. Выберите пункт user.
 Открывается окно User.

6. Откройте контекстное меню пункта Administrator → Properties.
 Открывается диалоговое окно User Properties.
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7. Откройте вкладку W@M.
 Открывается вкладка W@M.

8. Введите реквизиты User Name и Password, затем нажмите кнопку OK.
 Диалоговое окно User Properties закрывается.

9. Закройте программу Windows Explorer.
 Создается соединение с программой FieldCare для администратора.

Функции компонента W@M
1. Вызовите контекстное меню прибора.



2. Выберите пункт Device in Web → Show device specific details.
 Компонент W@M выполняет проверку возможности подключения.

3. Вызовите контекстное меню прибора.

4. Выберите пункт Documentation.
 Происходит вызов всех доступных функций компонента W@M.

ПО FieldCare содержит несколько функций для синхронизации данных программы
FieldCare с системой W@M Enterprise.
• Выгрузка параметров настройки, выполненной в автономном режиме, в систему

W@M
• Выгрузка параметров настройки, выполненной в интерактивном режиме, в систему

W@M
• Сравнение вариантов конфигурации, выполненных в автономном и интерактивном

режимах
• Сравнение вариантов конфигурации, выполненных в автономном режиме, с

архивными вариантами конфигурации
• Сравнение вариантов конфигурации, выполненных в интерактивном режиме, с

архивными вариантами конфигурации
• Сравнение различных архивных вариантов конфигурации
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5.2.3  Интеграция компонента Heartbeat Verification в систему
портала W@M

1. Выполните настройки в ПО FieldCare→   13.

2. Выполните настройки компонента FieldCare Administration→   14.

3. Выберите пункт W@M Configuration.
 Открывается диалоговое окно Connection.

4. Введите номер контракта W@M и нажмите кнопку Apply.

Пользователь получает номер контракта W@M, выбирая соответствующий
контракт на портале W@M.

5.3  Пользовательский интерфейс

 1 Главное диалоговое окно программы FieldCare

1 Ракурс установки
2 Ракурс сети
3 Строка меню
4 Панель инструментов
5 Ракурс DTM/параметров
6 Дополнительные диалоговые окна
7 Строка состояния

5.4  Общие настройки
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5.4.1  Настройки проекта
1. В окне программы FieldCare выберите пункт Extras → Options.

2. Откройте вкладку Project.
 Открывается вкладка Project.

3. Установите переключатель Prompt for project at start-up и нажмите кнопку OK.
 Диалоговое окно проекта отображается при каждом запуске программы.

5.4.2  Настройки сканирования
1. В окне программы FieldCare выберите пункт Extras → Options.

2. Откройте вкладку Scanning.
 Открывается вкладка Scanning.

3. Установите флажок Connect after scanning if only one device is found and
automatically open the DTM in the Online window и нажмите кнопку OK.
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После настройки сети отображается результат сканирования.

Если в результате сканирования программа FieldCare обнаруживает только один
прибор, автоматически устанавливается соединение с драйвером DTM и
происходит переключение в интерактивный режим. Если обнаружено несколько
приборов, то соединение с каждым драйвером DTM необходимо устанавливать
отдельно. В зависимости от драйвера DTM, выбор не подключенного к системе
прибора может привести к открыванию окна с предложением установить
подключение. В противном случае следует использовать вариант Connect.
Настройка отдельных приборов не описана в настоящем руководстве по
эксплуатации. Эта информация содержится в руководстве по эксплуатации
соответствующего прибора.

По умолчанию ПО FieldCare использует для сканирования интерфейс FDT 1.2.
Если выбрать вариант Prefer FDT 1.2.1 scan, то в качестве альтернативы будет
использовано сканирование через интерфейс FDT 1.2.1.

Использование FDT 1.2.1 предпочтительно с точки зрения быстродействия,
поскольку используются собственные драйверы Comm/Gateway DTM.

5.4.3  Ракурс установки
Изменения, происходящие в ракурсе сети, автоматически синхронизируются с
ракурсом установки. Изменения, выполняемые в ручном режиме в ракурсе
установки, не отражаются в ракурсе сети. Это дает возможность компоновать
установку вне зависимости от сетевой топологии.

Добавление уровня
1. Вызовите контекстное меню элемента.

2. Выберите пункт Plant View → Add Plant Level.
 Можно выбрать новый уровень установки.

 2 Структура ракурса установки

Уровень установки Описание

Enterprise Создайте только одну запись этого типа на высшем уровне (0).

Site
Area
Process cell
Unit

Создайте на уровне 1.
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Уровень установки Описание

Area
Process cell
Unit

Создайте для типа Site.

Process cell
Unit

Создайте для типа Area.

Unit Создайте для типа Process cell.

Analysis device
Digital device
Pressure
Special
Flow device
Level
Temperature device
Valve
Unknown device

Создайте для типа Unit.

Элемент Можно изменить элемент впоследствии с помощью функции
Change software.

 Это возможно ретроспективно не для всех типов. В этом
случае необходимо удалить тип и создать новый.

 Пункт можно логически связать с прибором в ракурсе сети с помощью функции Assign. Для
удаления связи следует использовать пункт Unassign Device.
Тексты заголовков для вех пунктов можно впоследствии изменить.
Для каждого пункта можно создать примечание с помощью контекстного меню, а также можно
создать ссылку для каждого пункта на файл или адрес URL веб-сайта.

Прежде чем создавать ракурс установки, необходимо создать ракурс сети. Ракурс
установки соответствует фактической топологии установки; технологический ракурс
представляет собой иерархическое представление производственного процесса.
Любой пользователь с уровнем доступа Planning engineer или более высоким уровнем
доступа может создавать ракурсы установок или редактировать существующие.

Элементы в ракурсе установки можно менять местами. Компоненты ракурса
установки можно переименовывать, добавлять или удалять.

Столбец Применение

Plant TAG Обозначение каждой позиции в рамках установки.

Connections Символ, указывающий состояние (интерактивное/автономное).

Status Указывает текущее состояние диагностики.

Monitored Пункт для активации мониторинга текущего прибора с помощью функции Condition
Monitoring.

Critical Пункт для причисления прибора к группе критически важных.

Channel Указывает канал, по которому подключен прибор.

Address Указывает адрес прибора, назначенный для этой позиции установки.

Device type (DTM) Указывает тип, к которому относится прибор.

Физический прибор Указывает физический прибор, находящийся в конкретной точке сети.

5.4.4  Ракурс сети
Ракурс сети – это графическое представление сети приборов, относящихся к проекту
FieldCare.

Столбец Применение

Network TAG Сетевое обозначение прибора.

Connections Символ, указывающий состояние (интерактивное/автономное).
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Столбец Применение

Channel Указывает канал, по которому подключен прибор.

Address Уникальный сетевой адрес прибора.

Device type (DTM) Указывает тип, к которому относится каждый отдельный прибор.

Физический прибор Указывает физический прибор, находящийся в конкретной точке сети.

5.5  Общие функции
Ракурс установки/сети
• Выбор пункта Контекстное меню → Customize Plant View
• Отображение диалоговых окон
• Отображение/скрытие столбцов
• Изменение расположения столбцов

Список функций
• Сортировка списка по заголовку столбца
• Изменение ширины столбца
• Изменение расположения столбцов с помощью функции копирования и вставки

5.6  Проверка сети
Сетевую топологию, которая отражена в ПО FieldCare, можно сравнить с фактической
конфигурацией физической сети. Это особенно полезно, если прибор добавляется в
существующую сеть. Проект может быть подготовлен в автономном режиме, а затем
загружен через ПО FieldCare. Таким образом можно проверить существующую
сетевую топологию и физическую топологию при внесении необходимых изменений.

Перед проверкой сети обратите внимание, что проверка проводится только для
устройств связи, с каждым из которых сопоставлен хотя бы один драйвер DTM. В
противном случае пункт меню Verify Network не активен.

Проверка сети
1. В ракурсе сети выберите прибор, для которого назначен по меньшей мере один

драйвер DTM.

2. Нажмите кнопку Verify network  на панели инструментов.
 Открывается диалоговое окно Communication channel.

3. Выберите необходимый канал и нажмите кнопку OK.
 ПО FieldCare сканирует выбранный канал.

По окончании проверки сети открывается диалоговое окно Scanning Result.
Отображается список активных устройств, а в столбце Status отражается
степень согласованности приборов в спланированной топологии с
фактической топологией.
Предусмотрено пять вариантов состояния
Типы и серийные номера приборов совпадают.
Типы приборов совпадают.
Типы приборов различаются.
Обнаружен новый прибор.
В проекте обнаружен не предусмотренный прибор.

4. Можно внести изменения с помощью контекстного меню соответствующего
прибора. Прочитайте/запишите данные прибора или замените тип прибора.
Нажмите кнопку OK, чтобы подтвердить внесение изменений.
 Изменения сохраняются.



FieldCare SFE500 Системная интеграция

Endress+Hauser 23

6  Системная интеграция

6.1  Настройка IP-адреса
• Необходимы права администратора
• Описание действительно для ОС Windows 7

Все устройства Endress+Hauser, оснащенные интерфейсом Ethernet, поставляются с
IP-адресом по умолчанию, например IP-адрес устройства Fieldgate FXA720 –
192.168.253.1. Для связи компьютера-хоста с веб-сервером устройства Fieldgate
FXA720 необходимо назначить IP-адрес в том же домене адресов, например
192.168.253.99. Дополнительные сведения можно получить у вашего сетевого
администратора.

Настройка IP-адреса для компьютера
1. Выберите пункт Пуск → Панель управления → Сеть и Интернет → Центр

управления сетями и общим доступом.
 Открывается диалоговое окно Сетевые подключения.

2. Выберите ссылку Управление сетевыми подключениями.

3. Вызовите контекстное меню подключения, которое следует изменить.

4. При необходимости
Введите пароль администратора или подтверждение.

5. Откройте вкладку Сеть.

6. Выберите пункт Протокол Интернета версии 4 (TCP/IPv4) в рубрике «Это
подключение использует следующие элементы».

7. Выберите пункт Свойства.

8. Запишите исходные значения IP-адреса и маски подсети компьютера, чтобы
восстановить их при необходимости в конце операции. Компьютер,
используемый в корпоративной сети, получит свой адрес автоматически.
Установите флажок Использовать следующий IP-адрес.

9. Введите IP-адрес, маску подсети и адрес шлюза по умолчанию в рубрике TCP/
IPv4.
 Настройки IP-адреса принимаются.

10. Нажмите кнопку OK.
 Процедура завершена.

6.2  Брандмауэр Windows
Если брандмауэр используется на компьютере, на котором работают и сервер, и
клиент, они должны быть запрограммированы для обеспечения взаимного
доступа. Настройка брандмауэра часто зависит от политики ИТ-безопасности
компании, поэтому необходимо проконсультироваться с
системным администратором, прежде чем продолжить работу. Кроме того, для
выполнения этой задачи требуются права администратора.

Порты, доступные для устройства Fieldgate SFG500, перечислены в следующей
таблице

Номер порта Идентификатор

TCP 60010 TCP_PCPS2_SFG500_PORT

UDP 60015 UDP_IDENTIFY_PORT

UDP 60020 UDP_ANNUNC_PORT
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Управление брандмауэром Windows
1. Выберите пункт Пуск → Панель управления → Брандмауэр Windows.

2. В левой панели выберите ссылку Разрешение запуска программы через
брандмауэр Windows.

3. При необходимости
Введите пароль администратора.

4. Установите флажок напротив программы, которой следует разрешить запуск, и
нажмите кнопку OK.

5. В левой панели выберите ссылку Дополнительные параметры.

6. При необходимости
Введите пароль администратора.

7. В диалоговом окне «Брандмауэр Windows в режиме повышенной безопасности»
выберите пункт Правила для входящих подключений.

8. В правой панели выберите пункт Создать правило....
9. Следуйте указаниям мастера создания правила для нового входящего

подключения.

10. Откройте вкладку Исключения.
 Открываются два главных уровня. К этим уровням можно добавить

исключения.
Пункт «Добавить программу» указывает, какие приложения могут отвечать
на запросы, поступающие в одностороннем порядке.
Пункт «Добавить порт» указывает, что брандмауэр должен допускать трафик
TCP через порты, используемые серверами.

11. На вкладке «Общие» установите флажок Включить (рекомендуется).

Брандмауэр активируется.
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7  Эксплуатация
В зависимости от режима хранения проекта, связанные с проектом данные
сохраняются в базе данных или в файлах.

7.1  Настройка языка управления
1. Запустите программу FieldCare.

2. Выберите пункт Extras → Options.
 Открывается диалоговое окно Options.

3. Выберите необходимый язык на вкладке Display и нажмите кнопку OK.
 Язык сохраняется и будет введен при следующем запуске программы.

7.2  Создание проекта
Первые этапы создания проекта всегда одинаковы. Диалоговое окно FieldCare
отображается по умолчанию; это можно изменить с помощью пункта Extras →
Options → Project. Диалоговое окно FieldCare не будет отображаться, если
установить флажок None.
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Создание проекта
1. Запустите программу FieldCare.

 Открывается диалоговое окно FieldCare.

2. На вкладке New выберите пункт Create Project и нажмите кнопку Open.
 Программа FieldCare откроет новый проект с помощью компьютера-хоста.

7.3  Сохранение проекта
Проекты FieldCare хранятся в базе данных, но недоступны в виде файлов на
жестком диске. Чтобы получить доступ к этим файлам, следует использовать ПО
FieldCare в файловом режиме. Все проекты сохраняются одинаково.

Сохранение проекта
1. Выберите пункт File → Save As.

 Открывается диалоговое окно Save Project As.

2. Введите название проекта и нажмите кнопку Save.
 Проект сохраняется.
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7.4  Открывание сохраненного проекта
Открывание сохраненного проекта
1. В диалоговом окне FieldCare откройте вкладку Existing.

 Открывается диалоговое окно Open Project. Отображаются проекты, которые
открывали последними.

2. Выберите проект и нажмите кнопку Open.
 Отображается проект.

Если проект не отображается на экране, выберите пункт View → Network.

7.5  Экспорт и импорт в формате CSV
Структурная информация о ракурсах установки и сети (топология установки/сети)
может быть экспортирована в файл CSV и импортирована из файла CSV в проект
FieldCare.

Импортирование файла CSV
1. Создайте проект. →   25

2. Выберите пункт File → Import/Export → Import CSV file.
 Открывается диалоговое окно Import CSV file.

3. Выберите файл и нажмите кнопку Open.
 Данные, которые содержатся в файле CSV, импортируются в ракурс

установки и (или) ракурс сети.

Экспортирование файла CSV
1. Выберите проект.

2. Выберите пункт File → Import/Export → Export CSV file.
 Открывается диалоговое окно Exported topology.

3. Нажмите кнопку Export.

4. Выберите место сохранения, название и нажмите кнопку Save.
 Ракурс сети экспортируется в файл CSV.

7.6  Информация DTM
Диалоговое окно Information содержит всю информацию, актуальную для драйверов
DTM.
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Отображение информации DTM
1. Выберите пункт Device catalog в строке меню.

2. Нажмите кнопку Display.
 Откроется каталог приборов.

3. Вызовите контекстное меню DTM.

4. Выберите пункт DTM Information.
 Откроется диалоговое окно Information.

Варианты, которые можно выбрать в диалоговом окне Information
• Отображение базовой информации обо всех типах приборов, которые поддерживает

драйвер DTM
• Отображение информации DTM:

• Идентификатор изготовителя
• Идентификатор типа прибора
• Идентификатор подтипа прибора
• Информация о типе прибора

7.7  Отображение каталога приборов
Диалоговое окно Device catalog содержит список всех драйверов DTM и FDI Packages,
которые содержатся в системе управления приборами. Драйверы DTM можно
группировать по категориям, изготовителям или протоколам.

1. Выберите пункт Device catalog в строке меню.

2. Нажмите кнопку Display.
 Откроется каталог приборов.

7.8  Обновление каталога приборов
Подробные сведения об обновлении каталога DTM см. в разделе «Обновление
каталога приборов: вводное руководство» →   7
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8  Диагностика и устранение неисправностей

8.1  Общие сведения об устранении неисправностей

Неисправность Меры по устранению

SQL-сервер ПО FieldCare
не запускается.

Запустите SQL-сервер вручную:
• Запустите ОС Windows и введите строку services.msc в поле поиска.
• Выберите SQL-сервер (SQLFIELDCARE).
• Нажмите кнопку Пуск.

Отсутствует макрос
сканирования.

Импортируйте макрос:
• В папку ...\Endress+Hauser\FieldCare\db импортируйте файл

ImportScanningMacros.cmd.
• Затем перезапустите программу FieldCare.

Дублируются пункты
меню или отсутствуют
окна.

Выполните сброс:
• Закройте программу FieldCare.
• В папке ...\Endress+Hauser\FieldCare\Profiles удалите файл profile.xml.

Нарушен каталог
приборов.

Сбросьте каталог приборов FieldCare:
• Закройте программу FieldCare.
• В папке ...\Endress+Hauser\FieldCare\Frame удалите файл

FRMRepository.xml.
• Снова запустите программу FieldCare и обновите каталог приборов.

Если проблема не будет решена, обратитесь в торговую организацию Endress
+Hauser: www.addresses.endress.com
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9  Обновления ПО
Подробные сведения об обновлении ПО см. во вводном руководстве →   7
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